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APPENDIX A 

GEOGRID PROPERTIES 



 

 

  Figure A-1 Geogrid BX1100 Product Specification 

A-1 



 

 

  Figure A-2 Geogrid BX1200 Product Specification 

A-2 



 

 

   Figure A-3 Geogrid TX130s Product Specification 

A-3 



 

 

  Figure A-4 Geogrid TX7 Product Specification 

A-4 



 

  

    

 

 

APPENDIX B 

LABORATORY DCP TEST RESULTS 



 

 

   

 

Date of Test 1/8/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

30.7 29.8 30.8 30.4 6.4

91.7 115.1 111.0 104.9 1.6

0.33 0.26 0.28 0.29 4.0

58.3 28.2 5.7 24.6 0.4

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

10" AB_Control

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 

2.5

Std. Dev.: Subgrade Layer [10 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course over compacted subgrade. Three tests conducted around the plate after cyclic PLT 

completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 46.9 21.6 20.5 28.0
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Figure B-1 DCP test results of section GE0 
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Date of Test 1/30/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

31.4 34.7 33.1 33.0 5.8

93.1 83.7 91.3 89.2 1.9

0.34 0.41 0.36 0.37 3.0

31.2 8.5 36.0 16.8 0.4

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

1.5

Std. Dev.: Subgrade Layer [10 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course over compacted subgrade and light duty BX geogrid placed at the sugrade/base 

course interface. Three tests conducted around the plate after cyclic PLT completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 5.3 14.6 13.1 9.8

10" AB_BX Light

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 
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Figure B-2 DCP test results of section GE1 

B-2 



 

 

   

Date of Test 1/23/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

27.1 24.0 27.4 26.1 7.6

104.5 103.1 79.1 94.0 1.8

0.26 0.23 0.35 0.28 4.2

10.6 31.9 12.9 9.2 0.2

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

2.5

Std. Dev.: Subgrade Layer [10 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course over compacted subgrade and heavy duty BX geogrid placed at the sugrade/base 

course interface. Three tests conducted around the plate after cyclic PLT completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 14.8 12.8 11.5 12.3

10" AB_BX Heavy

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 
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Figure B-3 DCP test results of section GE2 

B-3 



 

 

   

 

Date of Test 2/7/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

24.4 35.3 29.6 29.1 6.7

84.3 90.9 92.3 89.1 1.9

0.29 0.39 0.32 0.33 3.5

18.9 10.8 14.6 10.1 0.3

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

2.0

Std. Dev.: Subgrade Layer [10 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course over compacted subgrade and heavy duty TX geogrid placed at the sugrade/base 

course interface. Three tests conducted around the plate after cyclic PLT completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 9.4 15.3 14.2 10.6

10" AB_TX Heavy

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 
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Figure B-4 DCP test results of section GE3 
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Date of Test 2/7/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

24.4 35.3 29.6 29.1 6.7

84.3 90.9 92.3 89.1 1.9

0.29 0.39 0.32 0.33 3.5

18.9 10.8 14.6 10.1 0.3

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

2.0

Std. Dev.: Subgrade Layer [10 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course over compacted subgrade and heavy duty TX geogrid placed at the sugrade/base 

course interface. Three tests conducted around the plate after cyclic PLT completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 9.4 15.3 14.2 10.6

10" AB_TX Heavy

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 
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Figure B-5 DCP test results of section GE4 
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Date of Test 2/19/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

28.1 26.1 25.6 26.5 7.4

76.5 67.2 73.2 72.1 2.4

0.37 0.39 0.35 0.37 3.1

17.2 22.3 11.9 15.1 0.6

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

2.9

Std. Dev.: Subgrade Layer [10 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal  10  in. of aggregate base course over compacted subgrade and light duty BX geogrid placed at about 5 in. below surface (mid-

height of base). Three tests conducted around the plate after cyclic PLT completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 15.6 12.1 13.4 13.3

10" AB_BX Light_5

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 
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Figure B-6 DCP test results of section GE5 
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Date of Test 2/20/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

33.3 30.7 19.2 26.2 7.5

89.8 80.0 77.3 82.0 2.1

0.37 0.38 0.25 0.32 3.6

17.4 11.9 14.6 10.4 0.3

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

10" AB_TX Light_5

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 

2.1

Std. Dev.: Subgrade Layer [10 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course over compacted subgrade and light duty TX geogrid placed at about 5 in. below surface (at mid-

height of base course). Three tests conducted around the plate after cyclic PLT completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 9.7 11.4 4.6 7.3
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Figure B-7 DCP test results of section GE7 
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Date of Test 2/14/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

32.2 22.5 32.6 28.3 6.9

98.3 92.3 69.2 84.6 2.0

0.33 0.24 0.47 0.33 3.4

14.6 15.3 20.8 12.0 0.5

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

2.5

Std. Dev.: Subgrade Layer [10 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 6 in. of aggregate base course over compacted subgrade and heavy duty TX geogrid placed at the sugrade/base 

course interface. Three tests conducted around the plate after cyclic PLT completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 12.3 9.1 10.5 10.4

6" AB_TX Heavy

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 
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Figure B-8 DCP test results of section GE12 
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Date of Test 3/3/2020 Test ID Operator DW ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

#1 #2 #3
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

17.7 23.6 19.6 20.0 10.2

83.7 86.7 84.9 85.1 2.0

0.21 0.27 0.23 0.24 5.1

19.9 20.0 18.2 13.6 0.4

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Northfield, MN

4.4

Std. Dev.: Subgrade Layer [16 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 16 in. of aggregate base course over compacted subgrade and light duty TX geogrid placed at about 8 in. below surface (at mid-

height of base course). Three tests conducted around the plate after cyclic PLT completed with 12 inch diameter loading plate. 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 16.0 in.]

Average: Subgrade Layer [16 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 16 in.] 9.2 19.4 9.6 11.7

16" AB_TX Light_8

NA Longitude NA 

IMAS Test Box, Northfield, MN Station NA 
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Figure B-9 DCP test results of section GE15 

B-9 



 

  

 

 

Table B-1 Summary of laboratory DCP test results 

Test No. Test ϒd (pcf) ω (%)
Base AVG. 

CBR* (%)

Subgrade AVG. 

CBR* (%)
Date

GE0 Control 117.1 1.7 6.4 1.6 1/8/2020

GE1 BX Light_10 115.7 1.7 5.8 1.9 1/30/2020

GE2 BX Heavy_10 116.1 1.7 7.6 1.8 1/23/2020

GE4 TX Heavy_10 118.1 1.9 6.7 1.9 2/7/2020

GE5 BX Light_5_5 117.2 1.4 7.4 2.4 2/19/2020

GE7 TX Light_5_5 118.1 1.6 7.5 2.1 2/20/2020

GE12 TX Heavy_6 124.9 1.6 6.9 2.0 2/14/2020

GE15 TX Light_8_8 120.0 2.2 10.2 2.0 3/3/2020

AVG 118.4 1.7 7.3 2.0

B-10 



 

  

     

 

 

APPENDIX C 

SOIL AND AGGREGATE TEST RESULTS 



 

 

    Figure C-1 Base aggregate specifications (Minnesota DOT specification range for Class 5 aggregate) 

C-1 



 

 

  Figure C-2 Subgrade soil particle size analysis and classification 

C-2 



 

 

  Figure C-3 Subgrade soil laboratory proctor test results 

C-3 



 

 

  Figure C-4 Subgrade soil summary of CBR test results 

C-4 



 

 

  Figure C-5 Subgrade soil summary of resilient modulus test results 

C-5 



 

 

  Figure C-6 Subgrade soil summary of resilient modulus test results 

C-6 



 

 

 Figure C-7 Subgrade soil laboratory proctor test results 

C-7 



 

  

      

   

APPENDIX D 

LABORATORY SECTIONS PERFORMED PROCTOR TEST AND SAND 

CONE TEST RESULTS 



 

 

  

 

 

Table D-1 Base aggregate Proctor test results 

D-1 



 

 

  

 

 

 

 

 

  

Figure D-1 Base aggregate Proctor test graph 

D-2 



 

  
 

 
 

 
  

 

 
 

 

 

 
 

 

 
 

 

 

 
 

 

 

 
 

 

 
 

  

 

  

    

   

   

  

 

               

 

               

 

               

 

               

 

               

        

 

       

 

               

 

               

                

Table D-2 Base aggregate sand cone test results 
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APPENDIX E 

FIELD SECTIONS AGGREGATE TEST RESULTS 



 

 

    Figure E-1 Base aggregate specifications (Minnesota DOT specification range for Class 5 aggregate) 

E-1 



   

   

Figure E-2 Base aggregate specifications (Minnesota DOT specification range for Class 5 aggregate) 

Table E-1 Base aggregate sieve analysis test (Minnesota DOT specification range for Class 5 aggregate) 

Sieve No Mass retained Mass pass Total Percent pass

3 0 496.5 100%

2 0 496.5 100%

1.5 0 496.5 100%

1 0 496.5 100% 25.4

(3)/(4) 0 496.5 100% 19

0.5 0 496.5 100% 12.7

(3)/(8) 0 496.5 100% 9.51

4 0 496.5 100% 4.76

10 255.5 241 49% 2

20 69.5 171.5 35% 0.841

30 26 145.5 29% 0.595

50 46 99.5 20% 0.297

60 11 88.5 18% 0.25

80 19 69.5 14% 0.177

100 9 60.5 12% 0.149

200 34 26.5 5% 0.074

Pan 26.5 0 0%

Total 496.5

Base

E-2 



   

  

 

Figure E-3 Base aggregate specifications (Minnesota DOT specification range for Class 5 aggregate) 

Table E-2 Liquid Limit test 

Base 1 2

Mass of wet + can 36.9 62.88

Mass of dry +can 33.38 58.65

Mass of can 13.27 33.89

Dry soil 20.11 24.76

Mass of moisture 3.52 4.23

Water content 17.50% 17.08%

No. of Blows 22 30

Table E-3 Plastic Limit test (N.P.) 

Base 1

Mass of wet + can 35.39

Mass of dry +can 33.82

Mass of can 25.05

Dry soil 8.77

Mass of moisture 1.57

Water content 17.90%

E-3 



   

       

    

APPENDIX F 

FIELD TEST SECTIONS PERFORMED PROCTOR TEST, LFWD TEST, 

AND SAND CONE TEST RESULTS 



  Table F-1 Base aggregate Proctor test results 

F-1 



  

   

 

Figure F-1 Base aggregate Proctor test graph 

Table F-2 LFWD test results and details 

Subgrade Light Falling Weight Deflectometer test results, S Frontriver Dr., Mankato City, Mn

Test Section

Section No Left Centre Right Left Centre Right Left Centre Right Left Centre Right Left Centre Right Left Centre Right Left Centre Right Left Centre Right

Distance (ft) 12.5 25 37.5 62.5 75 87.5 112.5 125 137.5 162.5 175 187.5 212.5 225 237.5 262.5 275 287.5 312.5 325 337.5 362.5 375 387.5

Average δ (mm) 0.397 0.451 0.423 0.521 0.551 0.259 0.281 0.35 0.352 0.793 0.703 0.482 0.42 1.426 2.115 0.501 0.393 0.481 0.511 0.484 0.469 0.43 0.437 0.456

Evd (Mn/m2) 56.7 49.9 53.2 43.2 40.8 86.9 80.1 64.3 63.9 28.4 32 46.7 53.6 15.8 10.6 44.9 57.3 46.8 44 46.5 48 52.3 51.5 49.3

Date of the test 7/29/2020 7/30/2020 7/31/2020 8/1/2020 8/2/2020 8/3/2020 8/4/2020 8/5/2020 8/6/2020 8/7/2020 8/8/2020 8/9/2020 8/10/2020 8/11/2020 8/12/2020 8/13/2020 8/14/2020 8/15/2020 8/16/2020 8/17/2020 8/18/2020 8/19/2020 8/20/2020 8/21/2020

Temp 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny

Control (2) T12Control (1) T 1 T2 T4 T5 T7

Table F-3 LFWD test results 

Test Section East Lane T5 Control (2)

Section No - Centre Centre

Distance (ft) - 225 325

Average δ (mm) 3.028 3.935 0.49

Evd (Mn/m2) 7.4 5.7 45.9

Date of the test 7/29/2020 7/29/2020 7/29/2020

Temp 82֯ F, Sunny 82֯ F, Sunny 82֯ F, Sunny

F-2 



 Table F-4 LFWD test results 

Test Section

Section No Left Centre Right Left Centre Right

Distance (ft) 112.5 125 137.5 212.5 225 237.5

Average δ (mm) 0.269 0.399 0.242 0.568 5.041 3.223

Evd (Mn/m2) 83.6 56.4 93 39.6 4.5 7

Date of the test 7/30/2020 7/30/2020 7/30/2020 7/30/2020 7/30/2020 7/30/2020

Temp 74֯ F, Sunny 74֯ F, Sunny 74֯ F, Sunny 74֯ F, Sunny 74֯ F, Sunny 74֯ F, Sunny

T2 T5

F-3 



  Figure F-2 LFWD test results graph 
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  Table F-5 Sand cone test 
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APPENDIX G 

FIELD PERFORMED DCP TEST RESULTS 



 

 

    Figure G-1 DCP test results of control section 1, Ingios Geotechnics Inc. test results 

G-1 



   Figure G-2 DCP test results of control section 1, Ingios Geotechnics Inc. test results 

G-2 



   Figure G-3 DCP test results of section 2, Ingios Geotechnics Inc. test results 

G-3 



  Figure G-4 DCP test results of section 4, Ingios Geotechnics Inc. test results 

G-4 



    Figure G-5 DCP test results of section 5, Ingios Geotechnics Inc. test results 

G-5 



   Figure G-6 DCP test results of section 7, Ingios Geotechnics Inc. test results 

G-6 



     Figure G-7 DCP test results of control section 2, Ingios Geotechnics Inc. test results 

G-7 



   Figure G-8 DCP test results of section 12, Ingios Geotechnics Inc. test results 
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   Figure G-9 DCP test results of section 5, Ingios Geotechnics Inc. test results 
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Date of Test 7/31/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

7.0 5.9 6.3 6.4 36.8

3.5 5.3 3.5 3.8 64.9

1.99 1.11 1.78 1.66 0.6

2.2 1.0 1.4 1.5 22.5

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

10" Control  1

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 

11.6

Std. Dev.: Subgrade Layer [10 to 16.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 16.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 6.7 1.1 7.1 4.6
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Aggregate Base 

Right

Figure G-10 Average DCP test results of control section 1 
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Date of Test 8/1/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

5.6 7.0 7.1 6.5 35.9

3.9 4.0 3.9 4.1 59.7

1.41 1.74 1.82 1.57 0.6

1.1 1.7 1.6 1.2 20.1

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

7.6

Std. Dev.: Subgrade Layer [10 to 16.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Thin 6 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 6.0 in.]

Average: Subgrade Layer [6 to 18.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 2.3 0.6 5.3 1.9

6" Control  2

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 
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Figure G-11 Average DCP test results of control section 2 
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Date of Test 8/7/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

16.3 12.7 8.6 11.7 18.6

15.5 8.6 5.0 68.9 2.6

1.05 1.48 1.73 0.17 7.3

4.1 2.4 1.0 1.3 2.4

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

16" control section 3

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 

3.0

Std. Dev.: Subgrade Layer [16 to 24.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Thick 16 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 16.0 in.]

Average: Subgrade Layer [16 to 24.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 16 in.] 3.4 3.4 2.1 2.5
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Right

Figure G-12 Average DCP test results of control section 3 
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Date of Test 7/31/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

5.2 6.4 6.8 6.0 38.9

2.9 8.9 2.5 9.3 24.1

1.79 0.72 2.67 0.65 1.6

0.8 8.2 0.9 9.0 27.8

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

5.1

Std. Dev.: Subgrade Layer [10 to 16.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 16.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 1.6 0.9 0.9 0.8

10" T1 (Light Duty Biaxial)

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 
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Figure G-13 Average DCP test results of section 1 
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Date of Test 7/31/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

5.4 8.2 6.2 6.4 36.4

4.6 8.5 7.9 10.4 21.3

1.18 0.96 0.78 0.62 1.7

2.4 11.3 8.8 7.7 23.6

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

10" T2 (High Duty Biaxial)

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 

7.7

Std. Dev.: Subgrade Layer [10 to 16.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 16.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 0.4 7.6 1.0 2.7
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A-7-6(2), CL
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10 in. Class 5 
Aggregate Base 

Right

Figure G-14 Average DCP test results of section 2 
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Date of Test 7/31/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

6.0 7.6 5.1 6.0 39.1

6.3 18.1 3.4 23.7 8.4

0.94 0.42 1.47 0.25 4.6

11.6 18.1 1.2 19.0 19.2

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

8.1

Std. Dev.: Subgrade Layer [10 to 16.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 16.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 1.4 2.0 2.1 1.4

10" T4 (Heavy Duty Triaxial)

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 
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Figure G-15 Average DCP test results of section 4 
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Date of Test 7/31/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

5.7 5.6 6.1 5.8 40.6

3.2 4.9 7.2 4.9 49.5

1.79 1.14 0.84 1.19 0.8

1.1 1.9 1.2 1.7 13.1

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

10" T5 (Biaxial Ligh Duty- 

Center base position)

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 

9.1

Std. Dev.: Subgrade Layer [10 to 16.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 16.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 2.3 0.9 1.6 1.4
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Figure G-16 Average DCP test results of section 5 
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Date of Test 7/31/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

5.5 6.3 5.2 5.6 42.3

4.2 5.1 2.7 5.3 45.3

1.29 1.23 1.94 1.06 0.9

1.0 0.9 1.5 1.1 13.4

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

8.6

Std. Dev.: Subgrade Layer [10 to 16.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Nominal 10 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 10.0 in.]

Average: Subgrade Layer [10 to 16.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 2.0 1.3 1.5 1.4

10" T7 (Triaxial Light Duty - 

Center position)

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 
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Figure G-17 Average DCP test results of section 7 
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Date of Test 8/7/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

6.9 7.4 7.1 7.1 32.3

4.2 4.2 3.6 4.2 58.9

1.67 1.77 1.99 1.71 0.5

1.3 0.7 1.1 0.8 11.8

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

6" T12 (Triaxial Heavy Duty)

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 

4.4

Std. Dev.: Subgrade Layer [10 to 16.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Thick 16 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 6.0 in.]

Average: Subgrade Layer [6 to 19.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 10 in.] 1.6 0.5 1.6 1.1
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Figure G-18 Average DCP test results of section 12 
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Date of Test 8/7/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

8.3 9.1 8.0 8.5 26.7

5.9 7.6 4.7 5.8 40.5

1.41 1.20 1.71 1.45 0.7

0.9 1.8 1.9 1.1 7.8

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

6.2

Std. Dev.: Subgrade Layer [16 to 20.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Thick 16 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 16.0 in.]

Average: Subgrade Layer [16 to 20.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 16 in.] 3.0 1.8 1.4 1.8

16" T15

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 
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Figure G-19 Average DCP test results of section 15 
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Date of Test 8/7/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

9.7 9.1 8.0 8.9 25.3

7.2 7.6 4.7 6.2 37.9

1.34 1.20 1.71 1.43 0.7

16.9 1.8 1.9 6.3 14.8

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

16" T15 and control 3 

intersection test

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 

7.2

Std. Dev.: Subgrade Layer [16 to 20.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Thick 16 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 16.0 in.]

Average: Subgrade Layer [16 to 20.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 16 in.] 11.6 1.8 1.4 3.8
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Figure G-20 DCP test results of section 15 and control section 3 
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Date of Test 8/7/2020 Test ID Operator V. S. & H. A. ASTM D6951

Latitude Elevation (ft) NA

Location

Comments

Left Centre Right
AVG. DPI 

(mm/blow)
AVG. CBR* (%)

7.9 9.1 8.0 8.3 27.3

6.1 7.6 4.7 5.9 40.2

1.31 1.20 1.71 1.41 0.7

0.9 1.8 1.9 1.2 7.8

*Note: CBR = 292/(DPI)^1.12

Project Name: ISU_MNDOT_NS555_Geogrid Stabilization

Project ID: ISP_00007

Location: Mankato city, MN

5.3

Std. Dev.: Subgrade Layer [16 to 20.0 in.]

Dynamic Cone Penetrometer (DCP) Test Results

Thick 16 in. of aggregate base course Class 5 over compacted subgrade. Three tests conducted in each test sections 

DPI (mm/blow) Statistics

Average: Aggregate Base [0 to 16.0 in.]

Average: Subgrade Layer [16 to 20.0 in.]

Ratio of Average: Aggregate Base/Subgrade

Std. Dev.: Aggregate Base [0 to 16 in.] 2.6 1.8 1.4 1.6

16" T15 end lane point

NA Longitude NA 

S Riverdrive, Mankato city, MN Station NA 
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Figure G-21 DCP test results of the end of section 15 
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APPENDIX H 

FIELD TEST PICTURES AND LOCATION 



    

 

Figure H-1 condition of sites and procedure of construction of base and subgrade and setting the geogrids in the 

construction process 

H-1 



    

 

Figure H-2 condition of sites and procedure of construction of base and subgrade and setting the geogrids in the 

construction process 
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Figure H-3 condition of sites and procedure of construction of base and subgrade and setting the geogrids in the 

construction process 
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   Figure H-4 Project location and the field location in the city of Mankato and test arrangements 

H-4 



   Figure H-5 Project location and the field location in the city of Mankato and test arrangements 
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   Figure H-6 Project location and the field location in the city of Mankato and test arrangements 

H-6 



   Figure H-7 Project location and the field location in the city of Mankato and test arrangements 
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   Figure H-8 Project location and the field location in the city of Mankato and test arrangements 
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   Figure H-9 Project location and the field location in the city of Mankato and test arrangements 
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   Figure H-10 Project location and the field location in the city of Mankato and test arrangements 
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  Figure H-11 Project location and the field location in the city of Mankato and test arrangements 
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APPENDIX I 

TENSAR SOFTWARE SIMULATIONS INPUT PARAMETERS AND 

STEPS 



   

   

   

   

Input information for the roads in the spectra software was as below: 

For unreinforced section and section 1: 

Figure I-1 Input information for the roads in the spectra software 

Figure I-2 Input information for the roads in the spectra software 
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Figure I-3 Input information for the roads in the spectra software 

Figure I-4 Input information for the roads in the spectra software 
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Figure I-5 Input information for the roads in the spectra software 

Figure I-6 Input information for the roads in the spectra software 
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Figure I-7 Input information for the roads in the spectra software 

Figure I-8 Input information for the roads in the spectra software 
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Figure I-9 Input information for the roads in the spectra software 

Figure I-10 Input information for the roads in the spectra software 

I-5 



  

 

Figure I-11 Input information for the roads in the spectra software 

Figure I-12 Input information for the roads in the spectra software 

I-6 



 

   

   

 

 

 

APPENDIX J 

MNPAVE USER'S GUIDE 



 
 

 
 

 

 

 

  

 
     

      
 

Introduction 
MnPAVE is a computer program that combines known empirical relationships with a 
representation of the physics and mechanics behind flexible pavement behavior. The 
mechanistic portions of the program rely on finding the tensile strain at the bottom of the 
asphalt layer, the compressive strain at the top of the subgrade, and the maximum 
principal stress in the middle of the aggregate base layer. 

MnPAVE consists of three input modules: Climate, Traffic, and Structure; and three 
design levels: Basic, Intermediate, and Advanced. The level is selected based on the 
amount and quality of information known about the material properties and traffic data. 
In the basic mode, only a general knowledge of the materials and traffic data are 
required. The intermediate level corresponds to the amount of data currently required 
for Mn/DOT projects. The advanced level requires the determination of modulus values 
for all materials over the expected operating range of moisture and temperature. 

MnPAVE simulates traffic loads on a pavement using a Layered Elastic Analysis (LEA) 
called WESLEA.  It is a five-layer isotropic system program written in 1987 by Frans 
Van Cauwelaert at the Catholic Superior Industrial Institute Department of Civil 
Engineering in Belgium and modified in 1989 by Don R. Alexander at the U.S. Army 
Engineer Waterways Experiment Station in Vicksburg, Mississippi.  All layers are 
assumed to be isotropic in all directions and infinite in the horizontal direction. The fifth 
layer is assumed to be semi-infinite in the vertical direction.  Material inputs include 
layer thickness, modulus, Poisson’s ratio, and an index indicating the degree of slip 
between layers.  MnPAVE assumes zero slip at all layer interfaces.  Other inputs 
include load and evaluation locations. Loads are characterized by pressure and radius. 
The LEA program calculates normal and shear stress, normal strain, and displacement 
at specified locations. 

MnPAVE output includes the expected life of the pavement, which is calculated using a 
damage factor based on Miner's Hypothesis. Reliability is estimated using Monte Carlo 
simulation. There is also a batch section for testing a range of layer thicknesses. In 
Research Mode (accessible from the "View" menu in the main MnPAVE window), 
output includes various pavement responses for each season. 
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Units 
The default system of engineering units is English, however the system of units can be 
changed in any of the main modules.  System International (SI) or English units may be 
selected. 

English  SI 

Length 

1 in =   25.4 mm 

1 ft     =   0.3048 m 

1 mi =         1.609344 km 

Weight 

1 lb =   4.448222 N 

1 kip =         1000 lbs 

1 kip =         4.448222 kN 

Pressure (Modulus) 

1 psi =         6.894757 kPa 

(pounds per square inch) 

1 ksi = 1000 psi =    6.894757 Mpa 

J-2 



  

   

  
 

 

  

 

 

  

 
 

Starting MnPAVE 

The program can be started by double-clicking on the MnPAVE icon on the desktop 

or selecting MnPAVE from the Windows menu under the folder name specified 
in Step 6 of Installing MnPAVE. 

At this point, the Main Control Panel is visibile: 

Figure J-1 MnPAVE Software 

A new MnPAVE file can be opened by clicking on the icon or by selecting 
"New" from the "File" menu. 

An existing MnPAVE file can be opened by clicking on the icon or by selecting 
"Open" from the file menu.  A recently saved file can also be selected from the list at the 
bottom of the "File" menu. 
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Changes to the current file can by saved by clicking on the   or by selecting "Save" from 
the "File" menu.  Changes can be saved as a new file name by selecting "Save As" 
from the "File" menu. 

Project Information 
Project information is a form for entering information necessary to identify a MnPAVE 
project.  Mn/DOT District, county, city, highway, construction type, design engineer and 
project notes are entered in this module. 

Figure J-2 project information input part in MnPAVE software 
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Climate 
Climate contains a map of Minnesota where more specific location data can be entered. 
MnPAVE calculates season lengths and temperatures for each location using data from 
surrounding weather stations. 

MnPAVE has five default seasons based on material properties measured at the 
Mn/ROAD research site throughout the year. Spring is divided into two seasons 
because of the drastic changes in aggregate base and subgrade soil properties during 
the Spring thaw period. 

MnPAVE calculates the average pavement temperature for each season based on data 
from surrounding weather stations.  Details of this calculation can be viewed in the 
Details window. 

The county and district can be selected from menus in the Project Information window. 
Clicking on the map will also select them.  The season lengths and average seasonal 
temperatures are shown in the left portion of the Climate window. 

As the pointer moves over the map, the current district, county, and coordinates under 
the pointer are displayed to the left under Pointer Location.  Click the left mouse button 
to select this location.  The district and county can also be selected in Project 
Information. 

Figure J-3 climate district zones map in MnPAVE software 
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Climate Details 

Seasonal air and pavement temperatures can be viewed in this window. 

The air temperature at the selected location is based on a weighted average of data 
from weather stations in a 75 mile (120 km) radius.  Each seasonal air temperature 
value represents the average daily temperature for that season.  The equation used to 
convert air temperature to pavement temperature can be seen by clicking the 

button. 

Early Spring Thaw Depth is the assumed depth of the thawed/frozen interface during 
Early Spring.  The thawed portion of the base and/or soil is assumed to have a high 
moisture content and low modulus.  Seasonal modulus multipliers for the selected 
pavement materials can be viewed in Advanced Structure.  If the thaw depth extends 
into a soil layer, then the Late Spring multiplier is used for the thawed portion of the soil. 

Figure j-4 climate district zone details tab in MnPAVE software 
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Traffic 
ESAL (Equivalent Single Axle Load) is a simplified measure of traffic for pavement 
design.  An ESAL is defined as an 18 kip (80 kN) dual tire axle with a tire pressure of 80 
psi (552 kPa). Other axle loads and configurations can be converted to ESALs by using 
Load Equivalency Factors (LEF) as defined in Appendix D of the 1993 AASHTO Guide 
for Design of Pavement Structures. 

Lifetime ESALs are the number of ESALs expected during the number of years 
specified in Design Period Length. 
The First-Year value is calculated based on the Design Period Length and Growth Rate. 
If only First Year ESALs are known, it can be entered here and Lifetime ESALs will be 
calculated based on the Design Period Length and Growth Rate. The Design Period 
Length is typically 20 years. The Annual Growth Rate determines the amount that traffic 
increases during each year of the Design Period.  Traffic analysis conducted by 
Mn/DOT has indicated that a simple growth model is appropriate for most Minnesota 
routes (traffic increases by a fixed amount each year). 

  



 

 
 

Figure J-5 ESAL input section in MnPave software 

Allowable Stress is used to protect against failure in the aggregate base layer due to a 
single heavy load event. For this reason, the axle weights in this window represent the 
heaviest axles expected.  The default values for low-volume roads (less than 1,000,000 
ESALs) are legal axle weights in Minnesota. Values used for higher traffic volumes are 
consistent with data from around the state. 
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Structure 
When Structure is opened for the first time in a project, the HMA Mix Properties 
Window opens to make sure all mix design information is entered correctly.  Mix design 
information such as asphalt binder content and gradation are required to estimate the 
HMA dynamic modulus. Currently, the selection of a binder grade serves only to 
document the binders used in the design.  Only PG 58-28 data was available for the 
current MnPAVE calibration, so all HMA layers will have PG 58-28 properties regardless 
of the binder type selected. 

Up to three HMA types can be defined for layer 1.  Since the LEA procedure only allows 
five layers, multiple HMA layers are combined into a single layer using the equivalent 
thickness method. 

Click on the colored bar to select a default gradation based on a Mn/DOT specification. 
A custom gradation can be defined by entering numbers in the “Percent Passing” edit 
boxes. 

To view more details about how HMA modulus is calculated, click on the “Show Details” 
button and then the Advanced button next to each lift. 

The Structural Number (SN) is calculated using the method described in Section 2.3.5 
of the 1993 AASHTO Guide for Design of Pavement Structures. 

Figure J-6 HMA mix properties tab in MnPAVE software 
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Basic Structure 

Basic Structure is intended for low-volume roads or designs that don’t require a high 
degree of reliability.  MnPAVE uses default design modulus values.  These modulus 
values are adjusted for seasonal variations in moisture and temperature. 

Click on a layer button to select the number of layers in the pavement structure. The 
bottom layer is always semi-infinite.  A MnPAVE pavement structure must have 
between two and five layers. Due to limitations in the LEA procedure, layer 5 cannot be 
analyzed for rutting. Therefore layers 2 through 4 must contain at least one engineered 
soil1 or undisturbed soil2 layer. 

The Default Structures area provides shortcuts for several common pavement 
structures.  Select the desired pavement structure, then adjust the layer thicknesses 
and material subtypes. 

Material Types for each layer are selected on the left side of the Structure window under 
Edit Structure.  Layers with a white pointer arrow can be clicked to select a different 
subtype. R-Value Design can be clicked to view the traditional MNDOT design results 
for this structure. 

Figure J-7 Basic structure sublayers information in MnPAVE software 

1 
Soil that has been blended and compacted prior to construction. 

2 
Existing soil that has not been reworked. Because of uncertainty in the quality and uniformity of the 

material, the default undisturbed soil modulus is equal to half of the corresponding engineered soil 
modulus. 
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Confidence Level 

This value is used to adjust layer thickness and modulus values to assure that a 
proportion of the pavement area meets or exceeds the desired values, based on the 
coefficient of variation (COV).  The higher the confidence level and COV the more the 
value is reduced.  A confidence level of 50% results in no reduction (the mean value is 
used in the simulation).   The Confidence Level differs from the reliability value 
calculated in the Output Monte Carlo simulation.  The Confidence Level reduces the 
values for all layers and acts as a factor of safety to account for variability and 
uncertainty. A Monte Carlo simulation should be run on the final design to determine 
reliability.  In Design Mode, the Confidence Level is set at a default value of 70%. It is 
adjustable in Research Mode. 

Figure J-8 Confidence Level cure concept 
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Thickness Views 

Thickness Values Displays the design thickness.  These values are adjusted based on 
the Thickness Coefficient of Variation (COV) for the simulation. 

Thickness Coefficient of Variation indicates the variability of the thickness value of 
each layer. 

Adjusted Thickness Displays the reduced thickness used in the pavement simulation. 

a) b)  c) 

Figure J-9 thickness values in MnPave including a) thickness value tab, b) Coefficient of Variation (COV), c) 

adjusted thickness tab 
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Intermediate Structure 

Intermediate Structure has a form for entering test data for aggregate base and 
subgrade soils.  These values are converted to design modulus and adjusted for 
seasonal variations  If no test has been performed on a given material, it's box can be 
left unchecked to use default Basic material properties.  Basic HMA data is used in this 
mode.  A material subtype need not be selected if test data is entered. If the material 
subtype is known, it can be selected by clicking on the pointer arrow to the right of the 
edit box.  If the material subtype is not known, select Unknown from the list. To view 
the calculated moduli, click on the Advanced tab. 

If Other is selected in the Edit Structure area, material properties are edited in 
Intermediate or Advanced Structure. 

Figure J-10 Intermediate structure input tab in MnPave software 

Advanced Structure 

Advanced Structure requires the input of design modulus values for every layer and 
every layer. 

Design Mode:  Click on Basic, Intermediate, or Advanced to view the corresponding 
material properties below.  Selecting Basic or Intermediate displays values calculated 
based on data from those modules.  In Advanced mode, all material properties must be 
entered manually. 
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Figure J-11 advanced structure input tab in MnPave software 

The design mode is displayed above the “Finished” button to confirm that the correct 
mode is selected.  Any editing that is done in the Basic, Intermediate, or Advanced 
windows will change the mode. If any editing causes the wrong mode to be selected, 
this can be corrected prior to clicking on the “Finished” button. 

Import Moduli 

These buttons appear in the Advanced Structure window when Advanced Mode is 
selected. Basic default modulus values can be imported into Advanced Mode when 
custom values are not available for all layers and seasons. 
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Structure Views 

Structure views for all design levels can be viewed by clicking the Advanced tab. 

Design Modulus displays design modulus values.  For pavement simulations 
these values are adjusted according to the Confidence Level. 

Adjusted Modulus indicates how values used in the pavement simulation are 
adjusted according to the Confidence Level. 

Poisson's Ratio is a measure of a material's tendency to expand in the 
horizontal direction when it is compressed in the vertical direction. Poisson's 
Ratio is used in Layered Elastic Analysis (LEA) simulations. 

Seasonal Modulus Multipliers displays seasonal multipliers for each aggregate 
base, subbase, and soil material (HMA moduli are calculated for each season). 
Multipliers indicate moisture susceptibility and the state of the material (frozen or 
thawed). 

a) b) 

c)    d) 
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e) 

Figure J-12 Structure views in the Advanced tab in MnPave software including a) Design Modulus, b) Adjusted 

Modulus, c) Poisson's Ratio, d) Seasonal Modulus Multipliers, e) Modulus Coefficient of Variation 

Modulus Coefficient of Variation (COV) shows the expected variability in modulus for 
each layer along with the assumed distribution shape.  This data is used to determine 
the adjusted modulus values used in the simulation and the data set used for the Monte 
Carlo simulation in Output. 

The default modulus data used in MnPAVE fits a lognormal distribution (log-transformed 
data fits a normal distribution).  The COV of this data is calculated as follows: 

COV = e σ −1×100 
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Overlay Design 
While a complete Mechanistic-Empirical overlay design method has not yet been 
developed for MnPAVE, overlays can be designed using the conventional fatigue and 
rutting criteria to check for structural capacity. In addition, FWD3 deflections and the 
TONN method can be used to determine the necessary overlay thickness to avoid the 
need for Spring load restrictions. 

Basic Overlay Design Procedure 

While MnPAVE can check for fatigue, rutting, and shear failure in the aggregate base, 
these are often not the primary factors in determining overlay thickness.  When 
designing overlays in Basic mode, the designer must also rely on other overlay design 
methods and guidelines.  Do Project Information and Climate, and then go to Structure. 

Figure J-13 Basic overlay structure sublayers information in MnPAVE software 

Select the default overlay structure. If the old HMA properties for this layer have not yet 
been defined, the HMA Mix Properties window will open up. 

3 Falling-Weight Deflectometer:  A device that measures deflections that result from a 
weight dropped onto the pavement.  These deflections can be used to determine the 
modulus of the pavement layers. 
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Figure J-14 HMA mix properties tab in MnPAVE software 

If the HMA Mix Properties window did not open, click on the gray Old HMA subtype bar. 

Select the binder grade of the old HMA and any other mix properties that are known and 
click OK. 

Check the Mill and Overlay checkbox if applicable (the old HMA thickness should be the 
thickness after milling). 

Define the HMA properties for the new (overlay) HMA. 

Define the other pavement layers to the extent that their material types and thicknesses 
are known. 

Continue to Traffic and Output. 

If this is a Mill and Overlay project, HMA fatigue and subgrade rutting results will be 
displayed. If it is not a Mill and Overlay project and rutting has been observed in the old 
HMA, check the Rutting is present in old HMA box.  If rutting is not present in the 
existing HMA, it is not necessary to check for subgrade rutting. 
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Intermediate Overlay Design Procedure 

Select material types and subtypes for the layers, with HMA overlay in layer 1 and Old 
HMA in layer 2. 

Click on the Intermediate tab and select FWD Deflections. 

Figure J-15 Intermediate overly structure input tab in MnPave software 

The FWD Data window will open. FWD loads and deflections must be entered in the 
spreadsheet.  Data entry is greatly simplified by opening the FWD deflection file in a 
spreadsheet such as Excel, cutting and pasting to put the data in the appropriate 
columns, and then pasting the data into MnPAVE. 
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Figure J-16 FWD input data tab in MnPave software 

Pavement temperature can be entered by two methods. If the pavement temperature is 
known, uncheck the checkbox and enter the known pavement 
temperature values in column 2.  If the pavement temperature is not known, it can be 
estimated using the BELLS 3 method.  Enter the previous day's high and low air 
temperatures in the appropriate boxes and the infrared surface temperatures in column 

2. 

If Mill and Overlay was checked, the button must be clicked to define the old 
HMA thickness at the time of the FWD testing and after milling. 

Annual Average Daily Traffic (AADT) must also be entered.  If this value is not known, it 

can be estimated from the design ESALs and the road type by clicking on the 
button. 

Select the soil plasticity at the bottom by clicking on the button. Clicking 
on the button toggles through three levels:  Plastic, Semi-Plastic, and Non-Plastic. If 
this property is unknown, assume the soil is plastic. 

value is used in the TONN procedure.  This value is typically 0.11 
and ordinarily does not need to be changed. 
The
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Once all data has been entered, click on the   button. 

Figure J-17 FWD input data tab in MnPave software 

If BELLS3 was used, column 2 displays the estimated pavement temperatures at 1/3 of 
the pavement depth.  Column 3 displays the fwd load, and column 4 displays the center 
deflection normalized to a 9 kip (40 kN) load (all deflections are normalized for the 
calculations).  Column 5 displays the calculated HMA modulus and column 6 displays 
the Spring Load Restriction recommended by the TONN procedure for the selected 
overlay thickness.  Column 7 displays the overlay thickness recommended by the 
TONN procedure. The mean and standard deviation for these values is displayed at the 
bottom of the table. 
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Output 
Output displays the expected life based on fatigue and rutting damage.  Optimum layer 
thickness can be determined automatically in ESAL mode. 

Fatigue and Rutting Models 

The expected life of a pavement is calculated by simulating the strains due to traffic 
loads and using an empirical transfer function to determine the Allowed Repetitions4 for 
each load.  If the applied load repetitions exceeds the allowed repetitions, the pavement 
is assumed to have failed. 

Figure J-18 Fatigue damage function and details tab in MnPave software 

4 
The number of repetitions of a given axle load that are assumed to cause pavement failure by fatigue 

cracking or rutting 
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Initial Output 

Basic Output displays the expected years of pavement life based on calculated fatigue 
and rutting damage.  The pavement damage is also expressed as a percent contribution 
by each season. 

If fatigue or rutting values are too low or too high, Material subtypes and layer 
thicknesses can be adjusted.  After each change “Recalculate” must be clicked to view 
the new results.  For Basic designs, HMA and aggregate subtypes can be adjusted in 
Output. For Intermediate designs, only HMA can be adjusted in Output (other materials 
must be changed in Structure).  In Advanced mode, all material types must be changed 
in Structure. 

Figure J-19 Reliability input tab in MnPave software 

Thickness Goal Seek is a tool for determining design layer thicknesses in ESAL mode. 

To adjust the HMA layer only, select “Layer 1” and click on . A number 
of cycles will be executed until the pavement fails in neither fatigue nor rutting. 

When Thickness Goal Seek is done for non-HMA layers, the HMA layer will be adjusted 
for fatigue first (if necessary), and then the selected layer will be adjusted.  This is 
because adjusting underlying layers has a relatively small effect on fatigue life and may 
result in a large number of cycles and very thick layers. 

After running Thickness Goal Seek, layer thicknesses can be adjusted manually to 
obtain the desired structure. 
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Reliability 

Output reliability considers the variability of the thickness and modulus values for each 
layer to determine a reliability value for the pavement design. 

The reliability will not necessarily agree with the confidence level selected in Structure 
because the confidence level selects the "worst case" thickness and modulus value for 
each layer while the reliability analysis considers a random combination of thickness 
and modulus values. 

The number of Monte Carlo cycles can be adjusted by clicking the button. A 
sensitivity analysis was conducted to determine the optimum value of 2500 cycles. 

uses equations derived from running a range of full Monte Carlo 
simulations to estimate the Monte Carlo reliability for a given structure. This is a time-
saving feature that allows quick adjustments in the structure.  Once the desired quick 
reliability value is reached a full Monte Carlo reliability should be run for verification. 

button runs the selected number of Monte Carlo cycles.  The 
time for this process ranges from less than one minute to a few minutes for an ESAL 
design (depending on the computer's processor speed) and up to several hours for a 
load spectrum design. 

The 

Figure J-20 Reliability input tab in MnPave software 
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Reports 

A summary report can be saved as PDF file by clicking on the PDF icon or by 
selecting "PDF Design Summary" from the "File" menu 

A screen shot of the output window can be printed by clicking on the camera icon . 
Most other windows have a camera icon that can be clicked to print a screen shot. 

Basic Output 

Basic Output displays the expected years of pavement life based on calculated fatigue 
and rutting damage.  The pavement damage is also expressed as a percent contribution 
by each season. 

The relative damage effect from each season is displayed on the right side of the 
window.  These values are affected by both the magnitude of strain that occurs during 
each season as well as the season length. 

Results can be exported to a text file (comma or tab delimited) or to an “Excel” file. The 
Excel file is actually a tab delimited text file with an “xls” file extension.  Double-clicking 
on this file opens it in Excel, but it must be “Saved As” Excel to convert it to true Excel 
format. 

The Design Summary contains expected life and damage, project information, and 
limited structural and traffic information. 

Damage Details includes more seasonal and traffic information. 

Figure J-21 Basic Fatigue and rutting damage input tab in MnPave software 
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Batch Mode 

The batch mode allows the user to specify a range of layer thickness values and have 
all results tabulated in a text file or spreadsheet. 

Check the box for each layer for which the thickness will be varied. Type the thinnest 
value in the "Begin" box, the thickest value in the "End" box, and the amount to increase 
the thickness in the "Incr." box.  Damage Limits are used to exclude extremely over- or 
under-designed structures from the output file.  When Set Frost-Free Depth is selected, 
each simulated structure will be adjusted so that the specified thickness of granular or 
better material is placed above the subgrade soil. 

Selecting one of the output format buttons will prompt the user for a file 
name and then run the batch process. 

The value under Batch Cycles is the number of structures that will be simulated. If Set 
Damage Limits is checked, the number of lines in the output file may be fewer than this 
value. 

Figure J-22 Batch mode input damage limits tab in MnPave software 
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Research 
Mode 

The standard design mode in MnPAVE provides the features necessary to complete 
a pavement design. Research Mode can be selected from the Main Control Panel 
from the View menu. 

Figure J-23 Research mode selection in MnPave software 

In Research Mode there are more features and more flexibility in entering data. 

However, since data entered in Research Mode may fall outside the range of date used 

to calibrate MnPAVE, Research Mode is not recommended for pavement design 

J-26 


	Appendix B-MIDS Summaries (with page numbers).pdf
	Mod Case 1 - Existing Road - 5 segments - HSG A
	Mod Case 1 - Existing Road - 5 segments - HSG B
	Mod Case 1 - Existing Road - 5 segments - HSG C
	Mod Case 1 - Existing Road - 5 segments - HSG D
	Mod Case 1 - New Road - 5 segments - HSG A
	Mod Case 1 - New Road - 5 segments - HSG B
	Mod Case 1 - New Road - 5 segments - HSG C
	Mod Case 1 - New Road - 5 segments - HSG D
	Mod Case 2 - Existing Road - 1 segment - HSG A
	Mod Case 2 - Existing Road - 1 segment - HSG B
	Mod Case 2 - Existing Road - 1 segment - HSG C
	Mod Case 2 - Existing Road - 1 segment - HSG D
	Mod Case 2 - New Road - 5 segments - HSG A
	Mod Case 2 - New Road - 5 segments - HSG B
	Mod Case 2 - New Road - 5 segments - HSG C
	Mod Case 2 - New Road - 5 segments - HSG D
	Mod Case 3 - Existing Road - 5 segments - HSG A
	Mod Case 3 - Existing Road - 5 segments - HSG B
	Mod Case 3 - Existing Road - 5 segments - HSG C
	Mod Case 3 - Existing Road - 5 segments - HSG D
	Mod Case 3 - New Road - 5 segments - HSG A
	Mod Case 3 - New Road - 5 segments - HSG B
	Mod Case 3 - New Road - 5 segments - HSG C
	Mod Case 3 - New Road - 5 segments - HSG D
	Mod Case 4 - Existing Road - 5 segments - HSG A
	Mod Case 4 - Existing Road - 5 segments - HSG B
	Mod Case 4 - Existing Road - 5 segments - HSG C
	Mod Case 4 - Existing Road - 5 segments - HSG D
	Mod Case 4 - New Road - 5 segments - HSG A
	Mod Case 4 - New Road - 5 segments - HSG B
	Mod Case 4 - New Road - 5 segments - HSG C
	Mod Case 4 - New Road - 5 segments - HSG D
	Mod Case 5 - Existing Road - 5 segments - HSG A
	Mod Case 5 - Existing Road - 5 segments - HSG B
	Mod Case 5 - Existing Road - 5 segments - HSG C
	Mod Case 5 - Existing Road - 5 segments - HSG D
	Mod Case 5 - New Road - 5 segments - HSG A
	Mod Case 5 - New Road - 5 segments - HSG B
	Mod Case 5 - New Road - 5 segments - HSG C
	Mod Case 5 - New Road - 5 segments - HSG D





Accessibility Report





		Filename: 

		Effectiveness of Geotextiles_Appendices_REM.pdf









		Report created by: 

		Nellie Kamau, Catalog Librarian, Nellie.kamau.ctr@dot.gov



		Organization: 

		DOT, NTL







 [Personal and organization information from the Preferences > Identity dialog.]



Summary



The checker found problems which may prevent the document from being fully accessible.





		Needs manual check: 0



		Passed manually: 2



		Failed manually: 0



		Skipped: 0



		Passed: 29



		Failed: 1







Detailed Report





		Document





		Rule Name		Status		Description



		Accessibility permission flag		Passed		Accessibility permission flag must be set



		Image-only PDF		Passed		Document is not image-only PDF



		Tagged PDF		Passed		Document is tagged PDF



		Logical Reading Order		Passed manually		Document structure provides a logical reading order



		Primary language		Passed		Text language is specified



		Title		Passed		Document title is showing in title bar



		Bookmarks		Passed		Bookmarks are present in large documents



		Color contrast		Passed manually		Document has appropriate color contrast



		Page Content





		Rule Name		Status		Description



		Tagged content		Passed		All page content is tagged



		Tagged annotations		Passed		All annotations are tagged



		Tab order		Passed		Tab order is consistent with structure order



		Character encoding		Passed		Reliable character encoding is provided



		Tagged multimedia		Passed		All multimedia objects are tagged



		Screen flicker		Passed		Page will not cause screen flicker



		Scripts		Passed		No inaccessible scripts



		Timed responses		Passed		Page does not require timed responses



		Navigation links		Passed		Navigation links are not repetitive



		Forms





		Rule Name		Status		Description



		Tagged form fields		Passed		All form fields are tagged



		Field descriptions		Passed		All form fields have description



		Alternate Text





		Rule Name		Status		Description



		Figures alternate text		Passed		Figures require alternate text



		Nested alternate text		Passed		Alternate text that will never be read



		Associated with content		Passed		Alternate text must be associated with some content



		Hides annotation		Passed		Alternate text should not hide annotation



		Other elements alternate text		Passed		Other elements that require alternate text



		Tables





		Rule Name		Status		Description



		Rows		Passed		TR must be a child of Table, THead, TBody, or TFoot



		TH and TD		Passed		TH and TD must be children of TR



		Headers		Passed		Tables should have headers



		Regularity		Passed		Tables must contain the same number of columns in each row and rows in each column



		Summary		Failed		Tables must have a summary



		Lists





		Rule Name		Status		Description



		List items		Passed		LI must be a child of L



		Lbl and LBody		Passed		Lbl and LBody must be children of LI



		Headings





		Rule Name		Status		Description



		Appropriate nesting		Passed		Appropriate nesting










Back to Top



